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11 Background Removal 

In this chapter, we want to remove distracting background from a picture. That way, you can use 

the subject without the background and edit it further to your liking. 

 Setting a transparent color 11.1

If the background to be removed is single-colored, you can often achieve good results by defin-

ing the background color as transparent. This method only works with bitmap files (file extension 

e.g. .bmp, .png or less common .dib). A typical example for bitmap files are clip arts. 

Open the file Background removal source file.pptx and save it with the name Background 

removal1. Don't be surprised: In contrast to the other presentations in this training document, 

we used the 4:3 format here (page 32). 

 

Slide 1 with clip art 

On slide 1, you see a clip art on a light yellow slide background. The white background of the 

clip art is to be removed: 

1. Select the clip art. It is now bordered by the selection handles and the rotation handle and 

on the ribbon, the Picture Tools context tool appears. 

2. On the Fomat tab (Picture Tools), in the Adjust group, click the Color button and select 

Set Transparent Color from the submenu. 

http://www.dettmer-verlag.de/


 Schulungsunterlage Microsoft PowerPoint 2016 Weiterführung in Englisch  

 120 Musterseite aus dem Dettmer-Verlag, D-76889 Kapellen 

www.dettmer-verlag.de 

 

Making a color transparent 

3. The mouse pointer changed its appearance: . Use the mouse to click the color you want 

to make transparent, thus, in our example, the white background. 

 
Only one color can be made transparent and the definition applies to every occurance 

of the color in the picture. So, if you set the white background transparent, all the other 

white parts of the picture become transparent as well. 

4. The background is now transparent and the object blends in with the slide without the dis-

tracting background. Save the presentation without changing the name. 

 

The result without the white background 

 
You can also use this and the following methods for your own pictures and clip arts by 

inserting them into a presentation of your choice (page 106). 

 Removing the background 11.2

Often, the background to be removed isn't single-colored or the quality of the Set Transparent 

Color feature isn't sufficient, becaue the contours are ragged. To solve the problem, Microsoft 

integrated the Remove Background feature into Word, Excel, and PowerPoint in 2010 in order 

to remove multicolored backgrounds or distracting details as well. 
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Automatic background removal 

In many cases, you will achieve very good results using the so-called automatic background 

removal without much additional effort. The program tries to find out which part of the picture is 

the foreground and therefore is to be kept, and which part is the background to be removed and 

will become transparent. 

The current presentation has the file name Background removal1. Save it with the name 
Background removal2 and switch to slide 2. In this picture, we want to remove the back-
ground so that only the butterfly is visible. 

 

Original picture 

 

Result 

1. Select the picture so that it is bordered by the sizing and rotation handles and the Picture 

Tools appear with the Format tab. 

2. On the Format tab (Picture Tools), in the Adjust group, click the Remove Back-

ground button. PowerPoint inserts the Background Removal tab to the right of 

the File tab and determines automatically which parts of the picture are fore-

ground (normal coloring) and which are background (magenta):  

 

The automatically generated result 

3. As you can see, the tip of the left wing isn't defined as foreground, so, it would be cut off. 

Therefore, experiment a bit with the size and position of the marquee lines until the entire 

butterfly is displayed in its original colors. As soon as you release the mouse button, you will 

see the result: 

Background

(remove)

Foreground

(keep)

Marquee lines

(position and size adjustable)
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Changing the size of the marquee lines a bit 

4. Once you're satisfied with the result, click the button shown on the right on the 

Background Removal tab in the Close group.  
 

 
You can interrupt the background removal any time by clicking the Discard All 

Changes button (Background Removal tab, Close group). 

 

The final result 

5. Save the file without changing the name. 

 
Now, the background of the picture is transparent, not white. On the Design tab, in 

the Variants group, open the gallery via the More  icon and simply select another 

background from the submenu of the Background Styles command to make this fact 

clear. 

Marking the areas to keep or to remove 

There will always be pictures in which simply dragging the marquee lines won't generate the 

desired result, because PowerPoint cannot precisely detect foreground and background auto-

matically. For these cases, the Background Removal tab has a couple of features in store for 

further adjustment: 

 

The Background Removal tab 

Save the current presentation with the name Background removal3 and switch to slide 3. 

From this picture (Monument Valley), the front butte is to be separated. 

http://www.dettmer-verlag.de/


 Schulungsunterlage Microsoft PowerPoint 2016 Weiterführung in Englisch  

 123 Musterseite aus dem Dettmer-Verlag, D-76889 Kapellen 

www.dettmer-verlag.de 

 

Original picture 

 

Result 

1. Select the picture so that is is brodered by the sizing and rotation handles and the Picture 

Tools appear on the ribbon. 

2. On the Format tab (Picture Tools), in the Adjust group, click the Remove 

Background button. 

3. Change the size or position of the marquee lines until the result comes as close 

as possible to the desired result. 

4. On the Background Removal tab, in the Refine group, click the Mark Areas 

to Remove button to determine which parts of the picture are to be handled as 

background as well. 

 

 

5. Now, the mouse pointer looks like a pencil: . While holding down the left mouse button, 

draw a line  across the area you want to remove. PowerPoint interprets your 

line and adjusts the background accordingly. There are different possible solutions that lead 

to the desired result. Just try it. 

6. Now, click the Mark Areas to Keep button on the Background Removal tab in 

the Refine group to determine the areas you also want to keep in addition. Pro-

ceed exactly as described in step 5.  
 

 
If the result suggested by PowerPoint doesn't suit you, you can undo the 

changes using the button on the Quick Access Toolbar shown on the 

right. Alternatively, you can also delete individual marks using the Delete 

Mark button (Background Removal tab, Refine group). To do so, simply 

click  or . 

 

 

7. Your result could look like this: 

 

Picture with marks for areas to keep and to remove 
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8. Check from time to time what your work looks like by clicking somewhere outside the pic-

ture with the mouse or by pressing the (Esc) key. By clicking the Remove Background but-

ton, you get back to background removal mode. 

9. Once you're satisfied with the result, click the Keep Changes button on the 

Background Removal tab in the Close group and save the file without chang-

ing the name.  

Making the graphic smaller after the background removal 

The overall size of the picture hasn't changed due to the background removal, the background 

is merely transparent. If you think the picture is too big, you can crop it using the mouse: 

Select the picture by clicking it and on the Format tab (Picture Tools), in the Size 

group, click the upper part of the Crop button. The sizing handles become cropping 

handles and change their appearance. Point exactly to a corner sizing handle  

with the mouse. While holding down the left mouse button, drag a rectangle that 

corresponds to the desired cut-out. Release the mouse button and click anywhere 

outside the picture. The picture is cropped according to the rectangle. 

 

 

 

Cropping the picture by dragging the cropping handles 

 

Cropped picture 

Save the presentation with the name Background removal4. 

Applying picture effects 

You can apply various effects to the remaining picture after the background has been removed, 

such as shadows, reflections or glows. These effects are only applied to the remaining object. 

Save the presentation with the name Background removal effects. Select the remaining 

graphic on slide 3 and click the Picture Effects button on the Format tab (Picture Tools) in the 

Picture Styles group. Point to Shadow with the mouse to open the gallery with various shadow 

types. When you point to a shadow type, you'll already see the effect as a live preview. By click-

ing it you apply it. Just try a couple of different picture effects. In the end, we decided on the 

Perspective Lower Right shadow: 
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Remainig graphic with shadow (slide cut-out) 

Don't forget to save your changes. To undo a 

shadow effect, click the Picture Effects button 

again, point to Shadow, and select No Shadow 

from the gallery. The proceedings are the same 

for the other effects of this button.  

Selecting a shadow 
 

 
With the Corrections, Color and Artistic Effects buttons in the Adjust group, the 

Format tab (Picture Tools) provides you with a wide range of further options to apply 

effects to your remaining picture. Among others, you can change the sharpness, 

brightness and contrast, recolor the object or alter it by applying different artistic ef-

fects. 

Saving the remaining picture 

Up to now, we have always saved the graphics with the removed background in a presentation. 

There, you can copy them to the clipboard via the procedures you already know (e.g. Home tab, 

Clipboard group, Copy button) and paste them at another location (e.g. Paste button). 

However, you can also save the remaining picture in a folder of your choice. To do so, select 

the picture in the presentation, right-click it to open the context menu, and select the Save as 

Picture command. In the Save as Picture window, select the appropriate location, type a name 

into the File name field, and click [Save]. 

 Exercise 11.3

Open the file Background removal exercise.pptx and remove the background. You should 

receive the following result: 

 

Final result of the exercise  
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15 Presenting, Presentation Techniques 

 Starting a slide show 15.1

PowerPoints offers different ways to start a slide show: 

 Slide Show tab, Start Slide Show group, From Beginning button 

 Quick Access Toolbar, Start From Beginning  icon 

  (F5) key. 
 

In these cases, the slide show starts with slide number 1 or with the slide you have specified in 

the Set Up Show dialog box from page 169 (Slide Show tab, Set Up group, Set Up Slide 

Show button) in the From field below Show slides at the top on the right. 

If you want the slide show to start with the current slide, 

 click the  From Current Slide button in the Start Slide 

Show group or 

 Slide Show icon in the lower right corner of the window or 

 (Shift)+(F5) key combination. 

The buttons to the right appear when you move the mouse. 

 
The View icons on the status bar 

 

Buttons in the slide show 

 Navigating through the slides 15.2

Use the  icons or call up the context menu with a click of the right mouse button: 

 

Context menu in the slide show 

The Next and Previous commands in the menu correspond to the icons in the 

slide show. They are an alternative to pressing the (PgUp) (PgDn) keys and show 

the next or previous animation or slide. 

  

  
 
The pen icon opens the pointer options. 

  

The See All Slides icon displays all slides in thumbnail view, so that you can 

jump directly to any other slide.   

The Custom Show command in the context menu lists the names of all custom slide shows if 

you have defined any and displays the associated slides (a custom slide show contains a cer-

tain selection of slides from the current slide show, see page 171). 

Last Viewed jumps back to the previously displayd slide. 

Normal View

Slide Sorter

Slide Show

Reading View
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 Drawing during the slide show 15.3

While the slide show is running, you can use the mouse to draw directly on the slide, highlight 

important things, or circle them: 

1. Start the slide show. 

2. Right-click the slide and select Pointer Options or click 

the pen icon of the slide show buttons. 

 

Icons in the slide show 

3. A list is displayed. 

 
 

Selection of tools for drawing 

Context menu Pen icon 

4. Select e.g. Highlighter from the list. 

5. If need be, you can change the color beforehand, either with Ink Color (context menu) or 

the color palette (submenu of the pen icon). 

6. Now, draw on the slide and highlight important statements: 

  

Text highlighting 

7. Terminate using the highlighter by clicking the (Esc) key. 

8. Also try the Pen command. 

9. When you end the slide show, you are asked whether you want to [Keep] or [Discard] your 

ink annotations: 

 

Question when ending the slide show 

 
The Arrow Options command in the context menu 

opens the menu on the right.  

Arrow options 

  Automatic and 

 Visible 

The mouse pointer looks like an arrow and you can use it for 

pointing. 

  Hidden All icons in the slide show are hidden until you select Automatic 

or Visible again (e.g. right-click, context menu). 

 When you restart the slide show, the icons are automatically displayed again. 
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 Pausing or hiding the slide show 15.4

Right-clicking opens the context menu with the commands for pausing and resuming the slide 

show or hiding and showing it again. 

The Pause command stops a self-running slide show at the current slide. To continue the slide 

show, use the Resume command. 

The Screen, Black Screen command displays a black slide, Unblack Screen resumes the 

slide show. 

Alternatively, the White Screen command displays a white slide instead of a black one. The 

Unwhite Screen resumes the slide show. 

 

Commands in the slide show 

 Controlling the slide show with keys 15.5

During the presentation you can also control the progress of the slide show using keyboard 

shortcuts. In the context menu, click Help to display the list: 

 

Keyboard shortcuts during the slide show 
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 Presenter view 15.6

Presenter view supports you during your presentation in many 

ways. You can keep track of how much time has already elapsed, 

you see which slide appears next, and you can view your speaker 

notes privately, so that they aren't visible for the audience. 

First, make sure that Presenter view is activated  on the Slide 

Show tab in the Monitors group. As soon as two monitors are 

connected to your computer, PowerPoint automatically starts Pre-

senter view. The audience sees the show on the designated moni-

tor, the other, e.g. your laptop, shows Presenter view. 

However, you can also use Presenter view with only one monitor in 

order to rehearse your presentation: 

Switch to Slide Show view using the  icon on the status bar, for 

instance. Move the mouse and in the control bar that appears at 

the bottom left, click the icon with the 3 dots: . In the menu 

shown on the right, select the Show Presenter View command. 

 

Control bar in Slide Show view 

 

Presenter view activated? 

 

Show Presenter View 
 

 The control bar appears automatically when you move the cursor towards it. 

 

Presenter view 

The following table shows some of the icons in Presenter view: 

Icon Explanation 

 

Pen and laser pointer tools 

Opens a menu with different tools for writing on the slide, high-

lighting something or using the virtual laser pointer to point some-

thing out during the slide show. 

 

See all slides 

Shows thumbnails of all slides so that you can directly jump to a 

certain slide. 
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Icon Explanation 

 

Zoom into the slide 

Enlarge an area of the slide. 

 

Black or unblack slide show 

Pauses the slide show and displays a black screen instead or 

continues the show. 

 

More slide show options 

Opens a menu with further options (image on the previeous 

page), e.g. Hide Presenter View. 

 
Advance to the next/return to the previous slide. 

 

Swapping Presenter view and slide show on the monitors or  

duplicating the slide show. 

 Recording conversations during the slide show 15.7

Provided that a microphone is connected, you can record the discussions about the slides dur-

ing the slide show. 

To start the slide show, click the arrow  of the Record Slide 

Show button on the Slide Show tab in the Set Up group and 

select one of the options from the submenu: 

 Record from Current Slide 

 Record from Beginning. 

 

Record from … 
 

 

Starting the 
recording 

Via the button in the upper left corner you start the slide show including the record-

ing. Your screen shows Presenter view. 

To interrupt the recording briefly, click the Pause the recording button in the up-

per left corner: 

 

Pausing the recording 
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Resuming the 
recording 

 

Stopping the 
recording 

If you want to continue the recording, click the Resume the recording button in 

the upper left corner. 

To stop the recording, click th Stop the recording button in the upper left corner. 

You end the slide show by pressing the (Esc) key or clicking the Close icon  in 

the upper right corner. 

 

 
A discussion about the slide show should be recorded. That way, you can refer to it 

later or provide other people with it. 

 Slide show types 15.8

Presentation by a speaker 

Usually, the slide show is presented by a speaker who displays the slides successively with a 

click while talking about the slides. To make sure that this type of slide show starts after switch-

ing to Slide Show view by clicking the  icon on the status bar, the  Presented by a speaker 

option must be activated in the Set Up Show dialog box (Slide Show tab, Set Up group, Set 

Up Slide Show button). 

 

Selecting the Presented by a speaker option 

Self-running presentation 

A self-running presentation runs automatically and can be locked for manual manipulation. Such 

presentations can often be found at fairs. 

To ensure that the slide show runs automatically, you have to set the 

display time for all the slides first: On the Transitions tab, in the Timing 

group, deactivate the  On Mouse Click check box, activate the  

After check box, and select the time, e.g. 00:05. If you want to apply this 

display time to all slides, click the  Apply To All button (Timing group) 

afterward. However, you can also call up each slide and set individual 

display times. In doing so, don't forget to deactivate the  On Mouse 

Click option for each slide. 

 

Transitions tab,  
Timing group 

Moreover, in the Set Up Show dialog box, in the Advance slides area, the  Using timings, if 

present option must be activated so that the slide show moves automatically to the next slide, 

when the display time of a slide has elapsed. Activating the  Loop continuously until 'Esc' 

option in the Show options area makes the slide show start again after the last slide. 
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If you want to lock the presentation for manual manipulation, activate the  Browsed at a kiosk 

option in the Set Up Show dialog box in the Show type area. Then, the  Loop continuously 

until 'Esc' option is automatically activated. 

Interactive slide show / kiosk mode 

Also at fairs, you will often find slide shows that can be controlled interactively by the audience 

with the help of buttons regarding the progress and course of the show.  

For this type of slide show it is advisable to activate the  Browsed at a kiosk option in the Set 

Up Show dialog box, so that the show runs endlessly. The  Loop continuously until 'Esc' 

option is automatically activated and cannot be deactivated. Mouse clicks and keyboard inputs 

have no effect at all, action buttons and the (Esc) key on the other hand work as usual. It is ad-

visable to set the timings of the slide transitions. 

Slide transitions are motion effects that occur during the slide show when moving from one slide 

to the next. On the Transitions tab, in the Transition to This Slide group, you can select or 

remove (by selecting None) an effect and set the time in the Duration field of the Timing group. 

 

Selecting and adjusting the slide transition 

Instead of displaying the slides for a certain period, activate the  Manually option in the Ad-

vance slides area of the Set Up Show dialog box and insert interactive buttons on the slides 

for the visitors to control the slide show themselves. For instance, you could set up action but-

tons labeled Next and Previous which each display the next or previous slide (see chapter 4). 

Unless there is some interaction from the audience, the slide show starts again from the begin-

ning. To make sure, that no viewer ends the show by pressing the (Esc) key, you should re-

move the keyboard. The mouse, on the other hand, is necessary. 

 

Kiosk mode (cut-out) 

Showing the slide show in a window 

When you activate  Browsed by an individual (window) option in the Set Up Show dialog 

box, the slide show is presented in a window that can be restored down and allows switching to 

other programs temporarily. 

Slide show with selective slides 

If you don't want to show all slides of a presentation, you can hide the slides not to 

be shown: Select these slides and on the Slide Show tab, in the Set Up group, click 

the Hide Slide button. That way, you can also unhide them again.  
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Hidden slides are marked with  in the thumbnail pane on the 

left-hand side of Normal view and in Slide Sorter view. 

Custom Slide Show  

Another method to compile only some of the slides for certain 

slide shows is creating a so-called custom slide show. To do so, 

open the file Staff training and save it with the name Custom 

staff training. 

 

thumbnail pane 

 

Call up: Slide Show tab, Start Slide Show 

group, Custom Slide Show button, Custom 

Shows command. 

In the Custom Shows dialog box, click the 

[_New_] button and in the following dialog box, 

enter a name, e.g. Executive. 

  

 

New custom show 

 

Defining a custom slide show 

In the left pane, select  the required slides and click the [Add] button to add them to the Ex-

ecutive custom show. When you are finished compiling slides, close the window with the [_OK_] 

button. Use the [New] button to create another custom show. It could get the name Employee. 

To start a custom slide show, click the Custom 

Slide Show button on the Slide Show tab in 

the Start Slide Show group and select the 

name of the required slide show (in our exam-

ple Execuitve). 

However, you can also select the Custom 

Shows command, select the slide show in the 

dialog box shown on the right, and click [Show]. 

Via the [Edit] button you can compose the 

slide show anew. 

  

Starting a custom slide show 

 

Custom slide show 

If you want to create a custom slide show that mainly consists of the same slides as another 

already existing show, copy the existing one via the [Copy] button and modify it. The [Remove] 
button deletes a custom slide show. 
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Alternatively, you can also activate the  Custom show option in the Set Up Show dialog box 

(page 169), select the slide show you want in the associated list box , and start the show via 

the  icon on the status bar. The  All option displays all slides again. Another option is to 

specify the number of the first and last slide to be shown in the slide show in the  From and 

To fields. 

Presenting a slide show without animation and narration 

To present a slide show without animations or narration, activate the  Show without anima-

tion or  Show without narration option in the Set Up Show dialog box (page 169). 

 Printing slides 15.9

If you use a laser printer to print your presentation for an overhead projection, you need special 

overhead sheets so that the colors are visible during the projection. The sheets have to be high-

ly transparent and super clear. Laser printers apply the toner very densely and the toner parti-

cles scatter the light more than ink. A sheet that isn't fully clear in collaboration with a not-so-

bright overhead projector will simply produce a black and white projection. 

Modern, bright projector lamps in combination with highly transparent sheets usually help to 

show the slide in colors as well. 

Colored presentations can easily be printed in black and white. On the Print page of the File 

menu, in the Settings area, there is a selection button for: 

 Color 

 Grayscale or 

 Pure Black and White. 

Try out which setting generates the best result on your printer. 

Alternatively, you can design your own slide color scheme for the printout. Display the color 

scheme (Design tab, Variants group, More  icon, Colors) and select a palette in gray 

shades. You can also select the Customize Colors command from the submenu of the Colors 

menu item and create your own color scheme with different shades of gray (see page 37). This 

method lets you control black and white printouts very precisely. 

Printing handouts 

Handouts are intended for your audience. You can 

print the slides full-size or as images reduzed in size. 

The option can be found on the Print page of the File 

menu, in the Settings area. There, handouts are pro-

vided among other things in addition to the Full Pages 

Slides default option. Thereby, you can also select 

how many slides you want to appear on one page. 

Handouts have a master (page 31) on which you can 

define what headers and footers shall look like. The 

arrangement or size of the slides cannot be changed. 

 

Printing handouts 
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 General remarks on creating and presenting a slide show 15.10

Here are some tips for the common presentation situations: 

 Define your topic precisely and write down what you want to achieve or what message the 

audience shall receive. 

 What knowledge does the audience have regarding your topic? It determines how verbosely 

you have to speak and which language you use. Techincal terms have to be explained 

more often to a lay audience whereas experts would be bored. If the audience is mixed, you 

have to find a balance: Explain the technical term briefly for the laypeople and continue in 

technical language. 

 Collect every piece of information in advance and create a folder for the presentation in the 

file explorer just like you collect all information on paper in a folder. 

 Decide on the presentation device, e.g. beamer, overhead sheet, handout. Color design 

and font size depend on the devise. 

 Maybe take the trouble to write a script and hand it out. 

 Organize the invitations, stick to the specified times and topics. 

 Obtain information about your contact person on site who could provide pens, notepads, 

flipcharts or drinks, or to whom you can turn in the event of technical incidents. 

 Prepare the journey and make sure to take the address, floor, and room number with you. 

 Check the equipment of the room (technology, PC, laptop, beamer, overhead projector, 

outlets, cable reel, flipchart, etc.). 

Testing 
Once your presentation is complete, the testing and checking starts. The most important as-

pects are spelling, punctuation, and grammar. 

 Run the spelling checker in your presentation. 

 Check the grammar and punctuation. 

 Control the fonts or logo font of the company and the linkings or embeddings of objects. 

 Check if and in what version PowerPoint is installed on site or if you need the free Power-

Point Viewer. Save your presentation and viewer to a CD/USB flash drive – just in case. 

 If you take your own laptop along, make sure that the necessary fonts are installed and all 

the linked objects stored. 

 Don't forget the cables for power and beamer connection, the mouse and batteries for the 

remote control. 

Printouts 
Prepare all the documents you need as the speaker, e.g.: 

 an overview with the slide numbers 

 a printed outline 

 notes pages 

 maybe a printout of important text passages in a striking color 

 memo for the times 

 other information like addresses, phone numbers, invitations, list of participants, name tags. 
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Presentation/beginning of the presentation 
 Above all, a good presentation thrives on the content. The more thorough you are prepared, 

the better your presentation will be received by the audience. 

 Arrive on site sufficiently early. Depending on the kind of event it can be one or two hours 

prior to the start of your presentation. Make yourself familiar with the room (light, switches 

for blinds, cloakroom, drinks, restrooms, heating) and connect your devices. 

 Go to the end of the room and check the visual conditions. 

 Set up the room: flipchart, pens, name tags, documents for the participants. 

 Start the presentation and switch on the beamer. 

 Arrange your documents. 

 Now you should be ready to welcome your audience. Approach the arriving participants and 

confirm that they are in the right room. 

 Don't rummage through your documents anymore. Look up, smile at everyone, welcome 

them and help with the choice of seats and the clothes. 

 When all the participants have arrived, welcome them again shortly and introduce yourself: 

State your name and the topic of the presentation. 

 Ask whether everyone can hear and see you; ask if the lighting is pleasant. 

 Announce break times and lenghts. 

 Refer to the documents, handouts, etc. 

 If necessary, introduce the participants. 

 Present the topics, briefly summarize after each topic and move on to the next topic. 

 Answer questions either during the presentation, the breaks or in the end; you may even 

provide a blog and/or e-mail address. 

 Stick to the time allowance. 

 Speak loudly, clearly, and slowly. 

 Stand freely in front of or beside the table, stand up straight, stand beside the display area, 

not in front of it. 

 Keep eye contact with the audience.  

 Define binding breaks. 

End of the presentation and farewell 
 Summarize your presentation briefly and point out what was most important. 

 Thank the audience for their attention and wish them a pleasant journey home. 

 If you want to, display a final slide until the participants have left. 

 Don't tidy up the room while the participants leave. 

 Enable the standby mode of the beamer and let it cool off. 

 Turn all other devices off, tidy up. Only then, turn the beamer off. 
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